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THE LEARNING COMPANY, INC. LICENSE
AGREEMENT

Single-user Products

This is a legal agreement between you (either an individual or an entity) and The Learning
Company, Inc. (“The Learning Company”).  BY OPENING THE SEALED PACKAGES
CONTAINING THE DISKS OR BY USING THE SOFTWARE, YOU AGREE TO BE
BOUND BY THE TERMS OF THIS AGREEMENT. IF YOU DO NOT AGREE TO THE
TERMS OF THIS AGREEMENT, AND YOU ARE THE ORIGINAL PURCHASER OF
THE SOFTWARE, PROMPTLY RETURN THE SOFTWARE (INCLUDING PRINTED
MATERIALS) TO THE PLACE WHERE YOU PURCHASED THEM FOR A FULL
REFUND.

The Learning Company Software License

GRANT OF LICENSE.  This License Agreement permits you to use one copy of The
Learning Company software (the “Software”), which may include electronic
documentation, on a single computer/workstation. The Software is “in use” on a
computer when it is loaded into the temporary memory (i.e. RAM) or installed into
permanent memory (e.g. hard disk, CD-ROM drive or other storage device) of that
computer.  You may not use the software on or over a network or any other transfer
device without each concurrent user having an original copy of the Software and its
documentation.

COPYRIGHT.  All intellectual property rights in the Software (including all animations,
audio, images, maps, music, photographs, video, and text incorporated into the Software)
are owned by The Learning Company, its suppliers and licensors, and are protected by
United States copyright laws and international treaty provisions. The Learning Company,
its suppliers and licensors retain all rights not expressly granted. You must treat the
Software like any other copyrighted material, except that you may either make one copy
of the Software solely for backup or archival purposes or transfer the Software to a single
hard disk provided you keep the original solely for backup or archival purposes. You may
not copy the printed materials accompanying the Software.  You may not loan, rent or
lease the Software, but you may transfer your rights under this Agreement on a
permanent basis provided you transfer the license granted by this Agreement, the
Software and all associated printed materials, and retain no copies, and the recipient
agrees to the terms of this Agreement.  You may not reverse engineer, decompile or
disassemble the Software, except to the extent the this restriction is expressly prohibited
by applicable law.  You may not distribute printed copies of any user documentation
provided in electronic format.  The restrictions contained herein apply equally to hybrid
CD-ROMS which may contain multiple versions of the Software for use on different
operating systems.  Regardless of the type of media you receive, you may use only the
portion appropriate for your single-user computer/workstation.
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Limited Warranty

LIMITED WARRANTY.  The Learning Company, its suppliers and licensors warrant
that the media on which the Software is distributed are free from defects in materials and
workmanship for a period of ninety (90) days from the time of receipt. Any and all other
implied warranties with respect to the Software and the accompanying written materials,
including but not limited to implied warranties of merchantability and fitness for a
particular purpose, are limited to ninety (90) days.

REMEDIES.  Your exclusive remedies shall be, at The Learning Company’s sole option,
(a) the refund of the amount you paid for the Software or (b) repair or replacement of the
Software provided that (i) the defective Software is returned to The Learning Company
or an authorized dealer within ninety (90) days from the date of purchase and (ii) you
have completed and returned the enclosed registration card. This Limited Warranty is
void if failure of the Software has resulted from accident, abuse, or misapplication.  Any
replacement Software will be warranted for the remainder of the original warranty period
or thirty (30) days, whichever is longer.

LIMITATION OF LIABILITIES.  In no event will The Learning Company, its suppliers
AND licensors be liable for any indirect, special, incidental, economic, cover or
consequential damages arising out of the use of or inability to use the Software, user
documentation or related technical support, including without limitation, damages or
costs relating to the loss of profits, business, goodwill, data or computer programs, even if
advised of the possibility of such damages. In no event will The Learning Company, its
suppliers’ AND licensors’ liability exceed the amount paid by you for the Software.
Because some jurisdictions do not allow the exclusion or limitation of liability for
consequential or incidental damages, the above limitation may not apply to you.

U.S. Government Restricted Rights

U.S. GOVERNMENT RESTRICTED RIGHTS.  The Software and user documentation
is provided with RESTRICTED RIGHTS AND LIMITED RIGHTS. Use, duplication or
disclosure by the Government is subject to restrictions as set forth in subparagraph
(c)(1)(ii) of the Rights in Technical Data and Computer Software clause at DFARS
252.227-7013 or subparagraphs (c)(1) and (2) of the Commercial Computer Software—
Restricted Rights at 48 CFR 52.227-19, as applicable. The Learning Company, Inc., One
Athenaeum Street, Cambridge, MA 02142.

IMPORTANT NOTE:  In order to receive technical support and
notification of product upgrading and enhancements, please register
this product.

©1994-6 SoftKey Multimedia Inc., a subsidiary of SoftKey International Inc., and
©1994-6 Deltasoft Inc. All rights reserved. SoftKey is a registered trademark and
KeyCAD Pro is a trademark of SoftKey Multimedia Inc. Microsoft Windows and the
Windows logo are registered trademarks of Microsoft Corporation. Macintosh is a
registered trademark of Apple Computer Inc. All other trademarks are the property their
respective owners. Names and data used in sample screens and output with permission of
R. Kourtis, J. Parmenter, and K. and B. Reilly.
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Introduction

While you continue to improve your various drawing techniques with this
tutorial, you will find that new information is introduced in a gradual
manner. This will assure you of a precise learning process that can be
adjusted to your specific needs without having to acquire unnecessary
information before practising the basic design techniques.

The following tutorial has been created to further assist you in your
understanding of the basic features found within KeyCAD Pro, which
leads you to the many powerful design techniques available within the
program. It does this by providing a general design foundation from which
you can work within.

After completing the tutorial, you will be able to use the Draw Tools, Snap
To Tools, Edit Tools and Dimension Tools which are available within the
program. Finally, you will have an appreciation of how KeyCAD Pro
allows you to develop professionally detailed drawings with the least
amount of time and money invested.

To help in keeping this tutorial fast and user friendly, many of the KeyCAD
Pro features and combinations of tools were not included in this tutorial.
For more detailed and comprehensive coverage of how to use all features,
refer to the on-line User Manual.

System Requirements (Windows)

386 PC or higher
DOS 3.0 or higher
2MB of RAM minimum
A hard disk
Windows Compatible monitor
Microsoft Windows version 3.1 or higher
Windows Compatible mouse

KeyCAD Tutorial
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Recommended Hardware

4MB RAM
Math Coprocessor (KeyCAD Pro is fully functional without a
math coprocessor, however the Math coprocessor increases the
speed of the program.)
VGA Color Monitor or higher

System Requirements (Macintosh)

Macintosh SE/30 or higher
4MB RAM (5MB recommended)
System 6.0.7 or higher (System 7 recommended; System 7.1.2 or
higher required for PowerMacintosh(tm))

KeyCAD Pro Installation

Windows 95 Installation
Microsoft Windows 95 must be already installed on your PC in order to
install KeyCAD 2.0. With the computer turned on and Windows already
running:

1. Place the KeyCAD PRO CD-ROM into the CD-ROM drive.

2. Click on the Start button and select Run then type:

D:\START.EXE  and press ENTER, where D is the letter designation
of the CD-ROM drive. Follow the on-screen instructions to select
options and complete the installation.



Tutorial KeyCAD  Pro

8

Windows 3.1 Installation
Microsoft Windows Version 3.1 must already be installed in order to install
KeyCAD Pro. With the computer turned on and Windows already
running:

1. Place the KeyCAD Pro CD-ROM into the CD-ROM drive.

From the File Menu choose Run then type :

D:\START.EXE  and press ENTER

where D is the letter designation of the CD-ROM drive.

2. Alternatively access the File Manager and double click on the
SETUP.EXE program in the CD-ROM drive and directory. Refer to
the Windows Manual for the correct procedure.

The KeyCAD Pro CD-ROM installation program gives the user a
choice of installing either the program, the symbol libraries or both.
Choose the required option by clicking on it.

The KeyCAD Pro installation automatically installs both the program
and symbol libraries.

The user is then prompted for a directory name to install KeyCAD
Pro into. The default directory is C:\CADPRO. To accept the
default directory, click on OK or press ENTER.

3. To install to a different directory, type in the full path name of the
directory (drive and directory name), then click on OK or press
ENTER.

4. If the directory does not exist the installation program asks the user
to confirm the creation of the new directory. Press ENTER to create
the new directory or Cancel to enter a different path name.

At the conclusion of these instructions, KeyCAD Pro is fully installed and
ready for use.

Starting KeyCAD Pro (Windows)

The installation program automatically creates a program group and the
program item ready to run KeyCAD Pro. To start the program, double
click on the KeyCAD Pro icon. Also provided is a list of symbols included
with the program, to access this list, double click on the README icon.
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The README icon is only provided if the symbol libraries option is
chosen during the installation.

KeyCAD Pro is now installed and ready for use.

Macintosh Installation

Custom Installation Dialog Box (Macintosh)

1. Place the KeyCAD Pro CD-ROM into the CD-ROM drive.

2. Double click on the KeyCAD Pro Installer.

3. Follow the on screen instructions.

The KeyCAD Pro installation, installs both the program and symbol
libraries by default.

The user also has the choice of installing the symbol libraries, by choosing
Custom. Choose the required option by clicking on it. To choose multiple
options, press and hold the SHIFT key while clicking on your selections.

The user is then prompted for a directory name to install KeyCAD Pro
into. Click Install to copy the program to the default location or type
another location. Then, click Install to continue.

KeyCAD Pro is now installed and ready for use.
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Exercise 1

Create a 2.0 in. diameter circle with its center at the end-point of a
horizontal line.

Example Design

Answer 1
Step 1

First, select the Circle tool from the Draw toolbox, and draw a 2.0 in.
circle.  To draw the circle, move the cursor to the desired start point, click
and drag the mouse while holding down SHIFT.  Watch the readouts at
the bottom of the screen to obtain the correct size for the circle.

Circle Tool

                                 The Readouts Window

Diameter
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Step 2
Once a 2.0 in. diameter circle has been created, select the Line tool
from the Draw tools.

Line Tool

Step 3
Select the Center Point Snap To tool.  (Remember that the Snap To tools
are designed to work in conjunction with the Draw tools.)  The SnapTo
toolbox can be activated from the Toolboxes option under the Windows
menu.

Center Point Snap To Tool

Step 4
After you have selected the Draw and Snap To tools, place the cursor
near the boundary line of the circle and click and drag the mouse to the
desired line length while holding down SHIFT. Notice that when you
first click the mouse, the start point of the line automatically snaps to the
center point of the circle.

Place cursor near boundary line

Step 5
Release the mouse button once you have reached the desired line length.
(You can select a different Snap To tool for the  end-point of the line by
pressing the Tab key during the drawing of the line.)

NOTE: Holding the SHIFT key down while drawing the line, draws a line
only along the horizontal or vertical axis.
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Exercise 2
In this exercise, create a line perpendicular to a circle.

Example design

Answer 2
Step 1

You must first create a circle, the circle can be any size.  To draw a circle,
select the Circle tool from the Draw toolbox and place the cursor at the
desired start point. Then, click and drag the mouse while holding down
SHIFT. The SHIFT key allows you to create perfect circles, if you
release the SHIFT key the tool will draw ovals.

Circle Tool

Step 2
After you have drawn a circle, select the Line tool from the Draw
toolbox.

Line Tool

Step 3
Then, select the Perpendicular Snap To tool from the Snap To toolbox.
(Remember that the Snap To tools are designed to work in conjunction
with the Draw tools.)

Perpendicular Tool
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Step 4
Place the cursor near the boundary lines of the circle, then click and drag
the mouse to any desired line length.  Notice that the line you are
creating automatically snaps to a perpendicular position in relation to
the circle. The perpendicular angle is determined by the position of the
start point of the line. In this example, the start point of the line is fixed
at a horizontal position in relation to the circle.

Place cursor near the boundary line

Step 5
Once you have reached the desired line length, release the mouse
button. This method of creating a perpendicular line by combining
Draw tools with the Perpendicular Snap To tool, works with any of the
objects in the Draw toolbox.

Exercise 3

In the following exercise, draw a rectangle with it's start point at the
intersection point of two lines.  This exercise is designed to demonstrate
how you can start any object from the intersection point of any two objects.

Example design
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Answer 3
Step 1

First, create two lines that intersect as shown in the example above.
Use the Line tool from the Draw toolbox.

Line Tool

Step 2
Now, select the Rectangle tool from the Draw toolbox.

Step 3
Select the Intersection Snap To tool from the Snap To toolbox.

Step 4
Place the cursor near the intersection point of the two lines.  Then, click
and drag the mouse to create a rectangle, hold down the SHIFT key to
draw perfect squares.  Notice that the start point of the rectangle snaps
to the intersection point of the two lines.

Place cursor near intersection point

Step 5
Drag the mouse button to the desired size, and then release the mouse
button.  Watch the Readouts to obtain  certain dimensions. This method
of creating objects with their start points at the intersection point of any
two objects works with any intersection point, by combining Draw tools
with the Intersection Snap To tool.  (A different Snap To tool can be
selected for the end-point of the rectangle by pressing the Tab key
during the drawing of the rectangle.)

Rectangle Tool

Intersection Snap To Tool
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Exercise 4

The following exercise demonstrates how to use the Linear Dimension
tool, when dimensioning a rectangle. This example uses a simple object
such as a rectangle, but you can use the same steps when dimensioning
between any two points.

  Example Design

Answer 4
Step 1

First, create a rectangle similar to the one in the example above.  Use the
Rectangle tool when drawing your rectangle.

Rectangle Tool

Step 2
Select the Linear Dimension tool from the Dimension toolbox.

Linear Dimension Tool

Step 3
Double click the End-Point Snap To tool from the Snap To toolbox.

End-Point Snap To Tool

Step 4
Then, place the Dimension tool cursor near the first point of the
rectangle.  Click and hold down the mouse button while dragging the

1.833" 
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cursor to the second point of the rectangle. Release the mouse button at
the second point.  Since you selected the End-Point Snap To tool, the
dimension lines  automatically snap to the corner points of the rectangle.

Click near first point       Drag to second point

Step 5
After you release the mouse button at the second point of the dimension,
move the cursor away from the rectangle, notice how the dimension
lines follow the cursor movement.  Once you reach the desired distance
from the rectangle, click once to anchor the dimension.  After you click
the mouse button to anchor the text, the dimension  automatically
appears between the arrowheads. You can select a different Snap To tool
for the start or end-point of  the dimension you are creating by pressing
the Tab key during the drawing of the dimension.

Exercise 5

This exercise demonstrates how to use the Angular dimension tool.  The
following example illustrates a closed polygon with the 90 degree V-shape
in the middle of the polygon.

Example Design
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Answer 5
Step 1

Create a polygon similar to the one in the example shown above.
Use the Closed Polygon tool found in the Draw toolbox.

Polygon Tool

Step 2
After you have created the closed polygon, select the Angular
Dimension tool from the Dimension toolbox.

Angular Dimension Tool

Step 3
Select the End-Point Snap To tool from the Snap To toolbox. Be sure
to double click on the End-Point tool so that the tool is locked.

End-Point Snap To Tool

Step 4
Place the cursor near the angular point of reference as shown below.
Then, click and hold down the mouse button, while dragging the cursor
to the second point of the angled line. Once you are near the second point
of reference, release the mouse button. This operation indicates to the
program from which line you want to obtain an angular dimension.

Second point of reference

 Click near angular
point of reference
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Step 5
After you release the mouse button at the second point, notice how the
program has built an angular dimension line which follows the mouse
movements. Now, drag the cursor to the third reference point as shown
below, and click the mouse once. This is telling the program the size of
the angle you are dimensioning.  Drag the mouse away from the object
and click once to anchor the text and the arrows for the dimension.

Third point of reference

Exercise 6

In the following exercise create a closet that would be used in a typical
floorplan.  For the purpose of this exercise create the design using a scale
factor of 1/8" = 1'.

Example Design

 26'-0" 

 10'-0" Closet
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Answer 6
Step 1

The first step in creating the closet shown above, is to set the scale factor
of the design.  Select Rulers /Scale from the Layout menu. Set the
Screen Units to 0.25 Inches and the World Units to 2.0 Feet as shown
below.  Then, click on the OK button, your document has a scale factor
of 1/8" equals 1' foot.

The Rulers/Scale Dialog box

Step 2
Select the Parallel Dialog box from the Layout menu.  Select the
Inside option button and set the width to 1.00, then click on the OK
button. The Width value is in World units, feet.

Step 3
Now that the parallel options are set, select the Rectangle tool from the

The Parallel Format Dialog box
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Draw toolbox.  Then, select the Draw Parallel option from the Layout
menu, a check mark beside the option indicates that it is active.  Now
draw a 26'-0" (3-1/4") wide by 10'-0" (1-1/4") high rectangle.  This
represents the outer walls of the closet.

The Draw Parallel option

                                26'-0" or (3-1/4") wide

                                                                              10'-0" or
                                                                              (1-1/4") high

Step 4
Create a 3'-0" door for the closet.  Select the Rectangle tool, deselect the
Draw Parallel option and draw a  3'-0" (3/8") wide x 1'-0" (1/8") high
rectangle.

                  3'-0" (3/8") wide x 1'-0" (1/8") high rectangle
Step 5

Draw a 3'-0" (3/8") vertical line extending up from the upper lefthand
corner of the rectangle created in Step 4.  The example below shows how
the line and rectangle should look.

3'-0" (3/8") vertical line

Step 6
Now select the Arc tool from the Draw toolbox and draw a circular arc
from the upper right-hand corner of the rectangle to the end-point of the
vertical line.

      End-point of arc

     Start point of arc
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Place door 1' from left wall

Step 7
After creating the door, select all objects that make up the door by
dragging a selection rectangle around the entire door assembly, using
the Selection tool.  Then, select the Group command to group the entire
door assembly.  This helps in relocating the door to its proper position.
You can group objects by selecting the Group command from the
Options menu or by clicking on the Group button found on the Menu
Bar.

Menu Command Group Button

Step 8
Place the door in the proper location as shown below.  The door is 1'
from the left interior wall.

Step 9
Use the Polygon tool to create the shelf in the closet.  Draw the shelf
approximately 2'-4" wide.  Then place a dashed-line set back 1'-0" from
the edge of the shelf, this represents the clothes rod for hanging clothes
on.  Use the Polygon tool to create the dashed line.  You can change the
line type from the Lines option under the Layout menu.

Step 10
The Text can be added by selecting the Text tool in the Edit toolbox and
clicking once on the drawing to start typing.
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Type in the word 'Closet' then click on the Selection tool from the
Edit toolbox. The box frame for the text can be resized to better fit
the text.

To resize a text block, click and hold down the mouse button on one of
the four corner blocks while moving the cursor to change the size of the
text frame.  Now position the text in the middle of the closet.

Step 11
Now select the Linear Dimension tool and dimension the closet as
shown above.  Be sure to use the End-Point Snap To tool when
dimensioning the closet.

End-Point Snap To Tool

NOTE: To display the dimensions in Feet and Inches as shown above
select Readouts under the Layout menu and set the display to 0'-0".

Text corner
blocks

 26'-0" 

 10'-0" Closet
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Decimal Equivalents Inch / Fraction

Frac. Equiv. Frac. Equiv. Frac. Equiv. Frac. Equiv.
1/64 0.015625 17/64 0.265625 33/64 0.515625 49/64 0.765625
1/32 0.03125 9/32 0.28125 17/32 0.53125 25/32 0.78125
3/64 0.046875 19/64 0.296875 35/64 0.546875 51/64 0.796875
1/16 0.0625 5/16 0.3125 9/16 0.5625 13/16 0.8125
5/64 0.078125 21/64 0.328125 37/64 0.578125 53/64 0.828125

3/32 0.09375 11/32 0.34375 19/32 0.59375 27/32 0.84375
7/64 0.109375 23/64 0.359375 39/64 0.609375 55/64 0.859375
1/8 0.1250 3/8 0.3750 5/8 0.6250 7/8 0.8750
9/64 0.140625 25/64 0.390625 41/64 0.640625 57/64 0.890625
5/32 0.15625 13/32 0.40625 21/32 0.65625 29/32 0.90625

11/64 0.171875 27/64 0.421875 43/64 0.671875 59/64 0.921875
3/16 0.1875 7/16 0.4375 11/16 0.6875 15/16 0.9375
13/64 0.203125 29/64 0.453125 45/64 0.703125 61/64 0.953125
7/32 0.21875 5/32 0.46875 23/32 0.71875 31/3 20.96875
15/64 0.234375 31/64 0.484375 47/64 0.734375 63/64 0.984375
1/4 0.2500 1/2 0.5000 3/4 0.7500 1 1.0000

Metric Equivalents

MM In. MM In. In. MM In. MM
1 = 0.0394 17 = 0.6693 1/32 = 0.794 17/32 = 13.493
2 = 0.0787 18 = 0.7087 1/16 = 1.587 9/16 = 14.287
3 = 0.1181 19 = 0.7480 1/32 = 2.381 19/32 = 15.081
4 = 0.1575 20 = 0.7874 1/8 = 3.175 5/8 = 15.875
5 = 0.1969 21 = 0.8268 5/32 = 3.968 21/32 = 16.66

6 = 0.2362 22 = 0.8662 3/16 = 4.762 11/62 = 17.462
7 = 0.2756 23 = 0.9055 7/32 = 5.556 23/32 = 18.256
8 = 0.3150 24 = 0.9449 1/4 = 6.349 3/4 = 19.050
9 = 0.3543 25 = 0.9843 9/32 = 7.144 25/32 = 19.843
10 = 0.3937 26 = 1.0236 5/16 = 7.937 13/16 = 20.637

11 = 0.4331 27 = 1.0630 11/32 = 8.731 27/32 = 21.431
12 = 0.4724 28 = 1.1024 3/8 = 9.525 7/8 = 22.225
13 = 0.5118 29 = 1.1418 13/32 = 10.319 29/32 = 23.018
14 = 0.5512 30 = 1.1811 7/16 = 11.112 15/16 = 23.812
15 = 0.5906 31 = 1.2205 15/32 = 11.906 31/32 = 24.606
16 = 0.6299 32 = 1.2599 1/2 = 12.699 1 = 25.400



Tutorial KeyCAD  Pro

24

Glossary

Angular Dimensioning:  A tool found in the Dimension toolbox, which
allows dimensioning of angular objects or lines.

ANSI Standard:  The ANSI Standard is the most universal standard used
in the USA. ANSI stands for American National Standards Institute.

Application:  A program that has been created to perform a specific task
such as word processing, database information, spreadsheets, etc.  KeyCAD
Pro is an example of a graphics or draw application.

Arrowheads:  Arrows which appear at the end of the dimension lines
indicating the points being dimensioned.

Associative Dimensioning:  This means if one area of the dimensioned
object is adjusted, all parts of the dimension area are adjusted accordingly.
Any change to a single object or dimension causes all components of that
dimension to be automatically updated to reflect the new changes.

Axis Lines:  The lines that are positioned horizontally and vertically within
a document window. Axis lines help in providing guidelines for creating
objects horizontally and vertically.

Background Color:  The color that KeyCAD Pro uses to fill  any area that
is not filled with an object fill pattern or color.

Block:  A Block (Text Block) is the rectangular area enclosing any text that
has been typed in the document.

CAD:  Computer Aided Design - this is using a computer to assist in the
creation of blueprints or precision graphics.

Chamfer Tool:  An Edit tool which allows corners of joined objects to be
chamfered. Chamfering is the process of clipping off a corner of an object,
thus giving the object an angular corner.

Clipboard:  The clipboard allows text, graphics, and objects to be moved
within the same document, or to move objects to and from other applications.
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Dimension Line:  Shows the direction of any dimension. This line also
shows the relationship of a dimension to the referenced object.

Duplication Options:  Assigns duplication coordinates and repetitions to
any selected object.

Edit Tools:  Tools which appear in the Edit toolbox permitting the edit or
alteration of points and objects. These tools include selection, point
selection, resize, skew, rotate, chamfer, fillet, etc.

Elliptical Arc:  A tool found within the Draw toolbox which is used to
create curved lines.

Equilateral Triangle:  A triangle with three equal sides.

Extension Lines:   These lines occur when the dimension is established
outside of an object's boundary lines. These lines are designed to tie the
dimension line and the numerical value of the objects being dimensioned.

Fillet Tool:  An Edit tool which allows corners of objects to be rounded off
to a specific radius.

Floating Point Accuracy:  The format used for precise mathematical
computations. This format uses extended precision storage to avoid
excessive round-off errors in all objects created.

Ghost Lines:  These are dashed-lines which run parallel to the selected
points while moving or editing within a document. These lines move as the
mouse is repositioned.

Grow Buttons:  The small boxes found in the upper right-hand corner of
your window title bar. These buttons are activated by clicking them once
with the mouse cursor. These buttons are used to enlarge or decrease the
window size.

Horizontal Dimensioning:  An option in linear dimensioning for finding
the horizontal distance between any two points.

Isosceles Triangle:  A triangle with two equal length sides.

Layer:  A level in the document used to help in the organization of objects.
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KeyCAD Pro allows designs to be created in separate transparent sheets
and stacked on top of one another. Layers can be temporarily hidden to
view the document in different ways.

Linear Dimensioning:  A special tool found within the Dimension
toolbox, which allows the linear dimensioning of any two points.

Line Tool:  A tool found within the Draw toolbox, which is used to
construct individual horizontal or vertical lines of any length or angle.

Math Coprocessor:  Computer processing chip which aids in the
mathematical calculations of creating objects.

Numerical Value:  The number which is displayed when two points have
been dimensioned.

Origin:  The location which is represented as Zero for all Draw and Edit
tools. The Origin is also referred to as the Absolute Point of the document.

Precision Readouts:  The numeric values displayed at the bottom of the
document. This information window contains the Absolute, Incremental,
Percentage, and Angular information about objects and their position.

Radial Duplication:  This is where objects are rotated and duplicated
simultaneously around a specific point.

Relative Point:  The Relative Point represents a point in space against
which angles are measured. The Relative Point automatically has a circle
drawn around it.

Relocate:  To move objects to a new location or coordinate.

Resize:  The Edit function, that changes an object size.

Rotate:  An Edit function which allows objects to be moved around a fixed
point.

Scaling:  The process of assigning different scale factors to objects.
Scaling can be performed in English or Metric measurements.
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Scroll Bars:  The gray bar area at the right-hand side and bottom of each
document window. Press the arrows at the end of the scroll bars to move
across the drawing area within a window.

Selection Points:  The small circles and squares which appear at vertex
points within objects.

Skew:   An Edit function which allows objects to be slanted or sheared in
a specific direction.

Symbols:  An object or groups of objects which are saved in individual
files, with the capability of being recalled for future use.

Text Tool:  A tool found within the Edit toolbox which allows words,
sentences, and paragraphs to be created in blocks and placed anywhere
within your document

Toolbox:  A palette of tools which appear within the program window.

Vertical Dimension:  An option found within the Dimension toolbox for
finding the vertical dimensions of any two points.

X-Axis:  The horizontal plane in a document.

Y-Axis:  The vertical plane in a document.


